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Chapter 1
Introduction

Welcome to the Dissolved Oxygen Analyser software. This version is designed for the new 2-
channel titrator but it will work with all existing hardware versions. The highlights are:

a modern style program environment with optional mouse control
graphic display of the titration curves
new titration and endpoint calculation algorithms
support of WOCE and ISO 5813 (EN/ES/NE 25 813) specifications

The algorithms include on-line and post processing optimization to get rid of spurious
measuring points.

If you have a DO Analyser system, this manual will be part of the complete documentation. In
addition, we deliver this manual with the demonstration version to give you an introduction to
the features of the analyser.

1.1 Preface

This manual contains an introduction to the system. You will find information about installing
the hardware and the software and a tutorial to become familiar with the usage of the system.
If this is your first attempt at using the analyser, we strongly recommend you to start with the
demonstration version.

This tutorial does not contain any descriptions of the chemical methods for the measurement
of dissolved oxygen. The user should know the basics of titrimetry and the Winkler method.
For information on the preferred procedures for samples and chemicals and the calculations
see the users manual.

1.2 What Is the Dissolved Oxygen Analyser?

The DO Analyser is an easy to use, PC controlled instrument for the determination of
dissolved oxygen in aqueous solutions according to the method developed by L.W. Winkler in
1888.

This chemical titration method is the standard for determination of oxygen in samples even in
modern times, because all in situ systems are less accurate. The method needs well
educated and experienced personnel but nevertheless produces individual results because
the titration endpoint is determined by eye. Qualified personnel get very reproducible results
that have an individual offset. This offset limits the accuracy to a value considerably beyond
the general accuracy of the method. The current trend towards increasing international
cooperation and participation in joint programmes brings with it the greater need for
measurement comparability.
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The DO Analyser fills this gap for it works at the accuracy limit of the method, does not need
experienced and qualified personnel and potentially gives error free, well-documented results
on machine readable media. The acquisition, and the chemical pretreatment, of the samples
prior to titration are left unchanged but the determination of oxygen by titration of the iodine
with thiosulphate solution is automated.

The system consists of a robust transportable box containing the hardware, the software and
an interface cable from the box to PC. Within the box are a motor burette, a stand with a
stirrer for the sample flask, the photometer, and the interface box providing, via RS 232 serial
link, communication for photometer and burette with the computer.

1.3 Typographic Conventions

<Key> Angle brackets enclose a key on your keyboard. They are used  when
describing a particular key you should type, e.g. "Press <Esc> to cancel a
menu".

"TYPE" Quotation marks enclose a text you should type, e.g. "TYPE  README.DOC
<Enter>".

1.4 Acknowledgements

In this tutorial we refer to several products:

- Centronics is a registered trademark of Centronics Data Computer Corporation.
- IBM is a registered trademark of International Business Machines Inc.
- MS-DOS is a registered trademark of Microsoft Corporation.
- Hercules is a registered trademark of Hercules Computer Technology.
- Epson is a registered trademark of Seiko Epson Corp.

We thank Ralf Brown for his SPAWNO routines to minimize memory use while shelling to
DOS.
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1.5 Questions

If you have questions, wish to make suggestions or to report errors, we can be contacted by
letter or phone. Please include the following information or have it handy before you call:

- DOA software version number
- hardware version (1- or 2-channel system)
- computer type
- operating system and version number

Sensoren Instrumente Systeme GmbH
Muehlenkoppel 12
D-24222 Schwentinental
Germany
Tel.: +49-431-79972-0
Fax: +49-431-79972-11
Email: info@sis-germany.com
WWW: http://www.sis-germany.com
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Chapter 2
Getting Started

2.1 Packing List

The DOA system contains the following parts:

1 Sturdy box with
- Metrohm 665 Dosimat with user manual
- Magnetic stirrer with bottle mounting
- Photometer
- Interface box
- Hex driver set (1.5, 2, 3 and 6 mm)
- Bottle mounting without drill hole
- Burette accessories

1 Metrohm exchange unit
1 Mains cable
1 Serial link cable
1 Plug converter 9-pin D-SUB to 25-pin D-SUB
1 Mains plug converter
1 Software package (one 3½" DD and one 5¼" HD disk)
1 Tutorial
1 User manual
1 Technical reference manual

The demonstration software package contains one disk and this tutorial.

2.2 Technical Specifications

Dimensions: Sturdy box 43 cm x 54 cm x 41 cm (w x h x d)
17 in x 21 in x 16 in

Weight: 20 kg, 44 lb.
Power supply: Voltage 115 and 230 V AC

Frequency 50 . . . 60 Hz
Consumption 20 VA
Fuse 0.1 A time lag

Temperature range: Ambient temperature +5 . . . +40 °C
Storage, transport -40 . . . +70°C

Burette: Metrohm 665 Dosimat
Exchange unit 1, 5, 10, 20 or 50 ml
Accuracy Abs. Error ≤ 0.3%

Rep. Error ≤ 0.1%
Photometer: Low power light sources (Light Emitting Diodes)

15 Bit Analog-To-Digital Converter
Software: Menu driven user interface
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2.3 Hardware Requirements

IBM PC/XT/AT or true compatible

Operating system: MS-DOS 3.10 or higher
Processor: Minimum:   8088   Preferred: 80286
Memory: 640K (minimum 458K free memory)
Drives: Any with 1 MB free disk space; Hard disk preferred
Video card: MDA (no graphics), CGA, EGA, VGA, MCGA or Hercules (graphics only

with installed video support by MSHERC.COM)
Serial ports: One 8250, or compatible, based RS 232 C interface (Two for use with a

serial mouse)
Optional: Centronics interface for the use with Epson-FX or HP Laser Jet

compatible printer
Coprocessor
Mouse with Microsoft compatible mouse driver

2.4 Installation

2.4.1 Hardware Installation

If you only want to use the demonstration program, skip this part and turn directly to the
Software Installation.

Be sure that the power switch of the titrator is off and that the voltage selection matches your
mains supply (see plate at the rear side of the titrator box; to change voltage selection, see
the Technical Reference manual). Now connect the titrator to your mains supply and
assemble the Dosimat exchange unit according to the Dosimat instructions. If the exchange
unit is already assembled, switch the titrator and your computer off and connect the serial
interface cable to the interface box of the titrator and to the desired serial port of your
computer. If your computer has a 25-pin D-SUB connector, use the plug converter provided.

2.4.2 Software Installation

To copy the DOA software to your hard disk, insert the first diskette in your floppy drive, select
the drive, and type "DOAINST <Enter>". At first you are asked for the drive and directory to
copy the software. By default the main program is copied to C:\DOA\ and the demo files will
be copied to C:\DOA\DEMO\. Then you can select the language (English or German), the
method (WOCE or ISO and duplicate control) and the serial port for the hardware. Note that
all settings could be changed later by command line parameters or inside the program.

Now the installation program will copy the files to the DOA working directory and to the DEMO
subdirectory. The installation program itself will not be copied to the hard disk because it is not
needed anymore.

If you want to make backup copies of the original diskettes (and we very strongly recommend
that you do), just copy all the files from the original diskettes to the backup disks. It is possible
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to install and run the software from floppy disk rather than from hard disk, if you have 1 MB
free disk space.

2.5 List of Files

The analyser system comes with one distribution disk. It contains the following files:

DOAINST.EXE - Installation program
UNJARC.COM - Expander for packed files
DOA.JRC - Packed file with DOA software
DOADEMO.JRC - Packed file with DOA demo software
README.DOC - Text file with installation description and last minute information

After installation your destination disk contains:

DOA.EXE - Main program (only full version)
DOACAL.EXE - Calibration program (only full version)
DOAMULT.BAT - Example batch file for multiple configuration (only full version)
DOA_ENG.HLP - Help text file English language
DOA_GER.HLP - Help text file German language
DOA_ENG.NDX - Help index file English language
DOA_GER.NDX - Help index file German language
DOA_ENG.MSG - Message text file English language
DOA_GER.MSG - Message text file German language
DOA_ENG_STM - Status message text file English language
DOA_GER_STM - Status message text file German language
CONVBOT.EXE - Program to convert bottle files from older O2 plus versions into

   DOA version 3.x file format
MSHERC.COM - Resident program for graphic display with Hercules cards
README.DOC - Text file with last minute information
WHATSNEW.DOC - Text file with program history and additions to manuals
DOADEMO.EXE - Demonstration program
DOA.CFG - Default configuration file
DOA.BOT - Bottle data file for the demonstration program
ISO_D.DAT - Demonstration data file (ISO mode, with duplicates)
ISO_S.DAT - Demonstration data file (ISO mode, no duplicates)
WOCE_D.DAT - Demonstration data file (WOCE mode, with duplicates)
WOCE_S.DAT - Demonstration data file (WOCE mode, no duplicates)

2.6 The Readme Files

The files README.DOC and WHATSNEW.DOC contain last minute information about the
software and the hardware. So we recommend you to read these files before starting the
program. To do this, change to the DOA directory and type "TYPE README.DOC | MORE
<Enter>" at the DOS prompt or use your text editor.
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2.7 The Demonstration Program

Read this part even if you have the full version with the titrator. We recommend, that new or
inexperienced users start with the demonstration version.

The demonstration program DOADEMO.EXE works like the main program DOA.EXE.
However, the results of titration, standardization and blank determination may sometimes be
rather improbable, because they are produced by a random number generator. In particular
the curves will fit on the theoretical curves of light absorptions. As an alternative to the main
program you can select a demonstration mode for the old 1-channel hardware by the
command line option "/1". Note that the titration emulation of the demonstration program will
be faster than real titration with the main program.

2.8 Starting the Program

At first execution the program will start with default settings (English language, auto detection
for video mode). If you want to change these settings, use the command line options "/D" for
German language, "/M" for monochrome display, "/C" for colour display or "/L" for LC display.
The settings will be saved in a configuration file and are valid until you overwrite them by other
command line options. Note that there could be different configuration files for DOA.EXE and
DOADEMO.EXE because the files are stored in the current directories. To start the program,
change to the DOA or DEMO directory and type "DOA <Enter>" or "DOADEMO <Enter>".

After starting the program, you will see the main screen. At the top of the main screen is the
main menu bar, offering nine selections and displaying the current time at the right. At the
bottom is the status line with some short information about the current item you're on.

Figure 2.1 Main Menu
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Chapter 3
The Software Environment

3.1 Using the Menu System

To gain familiarity with the environment, here are some navigating basics.

From within a menu:

Keyboard: Use the highlighted capital letter to select a menu item, or use the arrow
keys to move to the option and press <Enter>.

Mouse: Move the mouse cursor to the desired option and click the left button.

Keyboard: Press <Esc> to exit a sub menu.
Mouse: Click the left button when the mouse cursor is outside the current menu

to exit a sub menu.

Keyboard: Use the <Right> and <Left> arrow keys to move from one pull-down
menu to another.

Mouse: Click the left mouse button when the mouse cursor is at the desired main
menu option to move from one pull-down menu to another.

From within a window:

Keyboard: Use the highlighted capital letter together with the Alt-key to select an
item, or use the <Tab> and <Shift-Tab> key to move to the option and
press <Enter>.

Mouse: Move the mouse cursor to the desired item and click the left button.

If there is a close field ([ ]) at the top left of the window:

Keyboard: Press <Esc> to leave the window.
Mouse: Click the left button at the close field to leave the window.

From within a text or data field:

Keyboard: Use the arrow keys or the <PgUp> and <PgDn> keys to move through
the field and press <Enter> to select.

Mouse: Click on the scroll-bar arrows to move one line up or down and click
above or below the position marker to move one page forward or
backwards. Select an item by clicking the left mouse button and activate
the item by double clicking on the left mouse button.

From within a group of entry fields:

Keyboard: Use the arrow keys to move to an entry field and enter your data by
typing.

Mouse: Click left at the desired entry field and enter the data by typing.
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To toggle a check box or select an item from radio buttons:

Keyboard: Move to the item and press the <Space-Bar>.
Mouse: Click left at the item.

3.2 How to Get Help

The DOA software gives context-sensitive on-screen help at nearly any point within the
program. If no context-sensitive help is available the help system will display the help-index
list. To call up Help, press <F1>. The Help window details the functions of the item on which
you're currently positioned. To get to the Help Index press <F1> again once you're in the Help
system. Inside the index list you can choose your desired help index to get the attached help
text. To move through a help text or through the help index list, use the cursor keys. Select
the help text from the index list by pressing <Enter>. To exit from help and return to your
menu selection, press <Esc> or the highlighted key from the cancel push button.

To get a first look at the help system select the Help on Help option from the Help menu:

Figure 3.1 Help on Help

3.3 Quitting the Program

To quit the program select the Quit option in the File menu. Note that there is no verifying
about quitting the program because all current data and settings will be saved automatically.



10

Chapter 4
Stepping Through the Menus

This chapter will step through all menus and windows like a first time user should do. Note
that all screen images are for the WOCE standard (some windows look different if you are in
ISO mode).

4.1 Options Menu

The first step in using the software, is the configuration of the system. To configure the
system, select the Configuration menu in the Options menu. To open the Options menu,
move the selection bar with the arrow keys and press <Enter>, press the hot key <O> or click
the left mouse button when the mouse cursor is at the desired menu item. Now you are in the
Options sub menu. From now on the usage of the keyboard or the mouse will only be
explained if something new appears.

Figure 4.1 Options Menu

This menu contains six standard items: Configuration, Titration Parameters, External
programs configuration, Transmission Test,  Hardware Test and Dosimat Functions. In
addition there are up to ten user defined entries to call external programs. At this time we
want to configure the system, so select the Configuration item in the same way as described
above. The other items are described later in this chapter.
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4.2 Configuration Menu

Figure 4.2 Configuration Menu

The configuration window contains settings in different styles. At the top there are seven items
with so-called radio buttons. The radio button idea is based upon the behaviour of the station
preset buttons of a car radio. Since the radio can only receive one station at a time, pressing
one radio button releases the other. Below right are two items with check boxes, which can
be toggled on or off. At the bottom of the window there are two push buttons. To select an
item or a radio button group, use the <Tab> or <Shift-Tab> key, click the left mouse button
when the mouse cursor is at the desired item or press the highlighted hot key together with
the Alt key. To move through the fields of a radio button group, use the arrow keys or the
mouse. To change the setting of a radio button group or a check box use the <Space-Bar> or
click the left mouse button. Configure your system now. The following descriptions explain the
purpose of each item:

Hardware Port Lets you select the serial port for your hardware. Note that no other
hardware should be connected to this port and no device driver should
be installed for this port, because this could produce unpredictable
results. The program will check your system allowing you only the
selection of existing ports. If you are running the demonstration program
the serial port selection doesn't matter, but consider that the settings are
stored in the configuration file which could later be loaded from the main
program.

Printer Port Lets you select the parallel port for your line printer. All printer output will
be directed to this port. The program will check your system allowing you
only the selection of existing ports.
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Fill Speed Lets you select four fixed burette fill speeds. The fill speed is only valid
for burette filling by the program (just before and after titration or if one
burette volume of titer is insufficient for titrating up to the end), not for
filling by the user. The maximum fill speed (three burette volumes per
minute) results in a total filling time of 23 seconds.

Method Select the procedure method for the determination of dissolved oxygen.
Many features of the WOCE recommendation, like temperature and
reagent corrections are not mentioned in the ISO standard, but they are
supported by the software even if you are in ISO mode. The most
important differences are at chemical pretreatment and standardization.
Therefore the program will produce  different messages and use
different equations for some options only. For a detailed description of
the chemical procedures and the equations see the user manual or the
WOCE and ISO specifications.

Note that the current standard and blank values will be set to zero if you
change the method. Therefore, you have to standardize your titer after
changing.

Video Type Lets you select your monitor type and video card. You can choose
between Monochrome (Black & White monitor with Hercules card), Color
(Color monitor with color card, e.g. CGA, EGA, VGA) and LCD (Liquid
Crystal Display or grey scale monitor).

Burette Volume Lets you select the cylinder volume of your burette. Be sure to have the
correct volume (it is printed in front of the exchange unit), because the
titration algorithms are based on the burette volume. If you are running
the demonstration program the burette volume doesn't matter, but
remember what we told you in the section Hardware Port.

Printer Emulation The DOA software supports two printer languages. These are Epson
FX-80 for a wide range of pin writers and HP Laser Jet (PCL) for Laser
Jets and compatibles. For more information see the User Manual,
chapter 5.1, Printers.

Duplicate Control Enable this option to titrate duplicate samples according to the WOCE
recommendations. Duplicate samples are two titrations from identical
samples. The absolute difference between the oxygen concentrations of
these titrations should be very small. The statistics about duplicate
samples and the ratio between duplicate and single samples are stored
in the data files. Therefore, we have two types of data files: Files with
and without duplicate samples. So you need a new data file for your
titration data if you toggle this option. The WOCE recommendations
require that all data sets submitted to WOCE must contain duplicate
samples (for at least 10% of the total number of samples taken). Even if
you do not intend to submit data to WOCE this option may be of interest
to you. This option is also available if you are in ISO mode.
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Split Printing Printing all data fields from one data set in one line will exceed the line
width of standard printers. If you do not have a wide carriage printer, you
can select Split Printing to split each page into two parts that can be put
together.

Save Saves the settings in the configuration file, leaves the Configuration
Window and returns you to the Options Menu.

Cancel Leaves the Configuration Window without saving the settings and
returns you to the Options Menu.

After configuration, select the Save push button to save the settings and return to the Options
menu. Before we can start our first titration, there are some more things to do.

4.3 Bottle Management

The next step is the creation of your bottles list because titrations can only be done when an
existing bottle is entered to the program. To create the bottles list, go back to the Main menu
and open the Bottle menu.

Figure 4.3 Bottle Management

The Bottle Management window lets you choose from adding, editing, or deleting bottles from
the list, printing the complete list, and save the bottles list.



14

View A sorted list of all bottles. You can move through the list using the <Up>,
<Down>, <PgUp> and <PgDn> key or by clicking on the scroll bar with the
mouse.

Add To add a new bottle to the list or edit the data of an existing bottle.

Delete Removes the currently selected bottle from the list.

Print Opens the Print menu and lets you print the complete list of bottles to your line
printer or a text file. The Print menu options are described later in this chapter.

Save Leaves the Bottle Management window and saves all data on disk.

Cancel Leaves the Bottle Management window without saving data.

If you are in the demonstration program you will probably see the above screen with the
demonstration bottle data, otherwise the View window will probably be blank. To enter bottle
data, select the Add item now.

4.4 Add Bottle

Figure 4.4 Add Bottle

Now we are in the Add Bottle window. If the bottle list is not empty, the entry fields will hold
the data for the currently selected bottle. You can edit this data or enter the data for a new
one. We will now step through the entry fields: The first one, labelled Number, holds the
number of your bottle. Enter a number between 1 and 999 and press <Enter> or the <Down>
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arrow key. You are now at the Volume entry field. Enter the volume of the bottle in ml. Note
that the volume is defined for the reference temperature of 20 °C. The last entry field contains
the cubical coefficient of thermal expansion for the particular glass. This coefficient is used to
calculate the real bottle volume for different temperatures. Typical coefficients are 1.0⋅10-5 for
borosilicate glass and 2.5⋅10-5 for soft glass. You have to enter the leading digits only, without
the exponential part of the coefficient. Valid inputs are in the range from 0.0 to 9.9. After
entering all data, leave the window by activating the OK button.

If your bottle is already part of the list, you will get a warning message to confirm the data has
been edited. If you want to leave the window without updating the bottle list, select the Cancel
button, press <Esc> or click the left mouse button when the mouse cursor is on the close
button at the top left of the window.

Now enter the data for all your bottles in the same way. When you have finished, select the
Save push button to save the bottle data and leave the Bottle Management window. Note that
the Bottle Management window has no close field at the top left of the window to prevent the
user from unintentional closing the window without saving the bottle data.

4.5 Standardization

The next step will be the first titration, not to determine dissolved oxygen, but to standardize
your titer. Without a valid standard volume you can't start a normal titration. So select the
Standard option from the Main menu.

Figure 4.5 Standardization
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The Standard window displays the data from the last standardization, lets you print them, and
lets you start a new standardization. If you are in ISO mode the window contains an additional
line displaying the titer concentration from the last determination. If you have just installed
your software, the data fields will display the default values and the standard volume will be
zero. Therefore, you must start a new standardization.

4.6 Standard Parameter

Figure 4.6 Standard Parameter

The Standard Parameter window has a group of four entry fields containing the data of the
last standardization. If this is the first determination or you are in ISO mode, the fields will hold
the default values. If you are in the demonstration program, you can take over the presetting
and start the determination, but you may be interested in the effects of extreme temperatures
(e.g. 0 or 40 °C) and coefficients (e.g. 9.9) on the results. So before we start, we will give
some information on the entry fields.

The ISO standard does not support any corrections for the standardization parameters.
Therefore all entry fields will hold default values, but it is possible to enter individual values. If
you use default values, the titer concentration is calculated according to ISO specifications.

The first field needs the volume of your pipette at the reference temperature of 20 °C, default
values are 10 ml for WOCE standard and 20 ml for ISO standard. The second field contains
the normality of your iodate standard at the same reference temperature, 20 °C, as the pipette
volume. The default values are 0.01 N for WOCE mode and 10 mmol/l for ISO standard. The
third field specifies the current temperature of your iodate standard (default 20 °C) and the
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last field requires the cubical coefficient of thermal expansion of your iodate pipette (default 0).
This coefficient is used in the same way as described in the Add Bottle window.

We have now reached the first point where there are differences between the old 1-channel
hardware and the new 2-channel hardware. Even if you are in the demonstration program
(remember the command line option "/1") these differences will affect the next events.

1-channel system: Place the bottle in the photometer, switch the stirrer on and dip the
burette tip a little way into the sample. Start the determination. The
Primary Shot window will appear on the screen.

Figure 4.7 Primary Shot

The Primary Shot window lets you enter an absolute primary shot of
thiosulphate titer in ml (e.g. "0.65") or a percentage of transmission value
by entering a leading minus (e.g. "-65"). When entering a primary shot
the titrator will dispense the given amount at once, wait a moment and
titrate slowly with small titer amounts until the sample is transparent. For
percentage input, the program will titrate in a fast way with decreasing
amounts of titer until the given transmission is reached, wait a moment
and titrate slowly with small titer amounts until the sample is transparent.

2-channel system: Start the determination. If your bottle is already in the photometer path,
an error message will pop up, requesting you to remove the bottle,
because the system will now calibrate the two channels. After the
calibration, a message pops up, asking for the bottle. Place the bottle in
the photometer, switch the stirrer on, dip the burette tip a little way into
the sample and confirm the message.
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While the titration of the standard solution is running, you will see the Titration Running
window on the screen.

Figure 4.8 Standardization Running

The Titration Running window gives you information about the current amount of dispensed
titer, the current percentage transmission, the estimated (or entered) transmission endpoint
(not for primary shot with 1-channel systems), the time since starting the determination and
the current action. If you want to interrupt the titration just press <Esc>, but note that although
continuation of the titration is possible it can give inaccurate results.

When the standard determination has successfully completed, the Standard Determination
window comes up to the screen.
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4.7 Standard Determination

Figure 4.9 First Standard Determination

This window gives you five selections to choose from. You can decide to make another
titration to get a more precise standard value by selecting 'Next' or save the current value by
choosing 'OK'. With 'Graph' you can display the titration curve. This option will be described
later in the chapter, because it does the same as the 'Graph' option in the main menu. With
'Log' you can write the titration data (titer-transmission table, titer endpoint, maximum
transmission) to an ASCII file or print them on a line printer. After activation the Log menu will
pop up, asking for the output device (file or printer). The Log menu is similar to the Print
menu, which will be described later in the chapter. 'Cancel' will interrupt the standard
determination and return you to the Standardization window.

If you make more than one standard titration you can disable single titration results if they
seemed to be incorrect. The resulting standard value is then calculated from the average of all
enabled titration. So choose 'Next' for some more titrations.
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Figure 4.10 Additional Standard Determination

Disable now some titrations by clicking with the mouse on the check boxes or by pressing the
corresponding number and have a look on the resulting average and accuracy. The accuracy
is the percentage standard deviation of all enabled titration values.

The total number of standard titrations is limited to ten. Therefore, the Standard Determination
window contains no 'Next' button after the tenth titration.

When all titrations are done, press 'OK' to save the data from this determination. You will
return to the Standardization window, which now displays the new standard value and the
current system date and time. If you have entered an extreme temperature and/or coefficient,
look at the temperature corrected values for the pipette volume and standard normality. The
last data field shows the calculated amount of titer for the standard.

To obtain correct titration results, the blank value for your reagents is now required. To
determine the blank value select the option Blankvalue from the Main menu.
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4.8 Blank Value

Figure 4.11 Blank Value

The Blankvalue window displays date, time and the result of the last blank determination. If
you have just installed your software the blank value will be zero. The blank value is not
necessary to start a titration, but it is needed to get accurate results from oxygen
determinations. The options in this window are the same as in the Standard window, with the
difference that Determination will begin immediately.

Blank values are not mentioned in the ISO specifications, but if you do make a blank
determination the value will be used for oxygen concentration calculations.

After starting the determination you are prompted for adding 1 ml iodate, the reagents and
starting the titration. If you use a 1-channel system, the Primary Shot window will appear on
the screen, prompting in the same way as for standardization.

If the titration was successfully the result of the first titration is displayed in the Blank
Determination window.
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4.9 Blank Determination

Figure 4.12 First Blank Determination

This window gives you four selections to choose from. 'Next' will start the second titration
which is necessary to determine the blank value. The 'Graph' and 'Log' buttons have the
same function as in the Standard Determination window. 'Cancel' will interrupt the blank
determination and return you to the Blank Value window.

So choose 'Next' to start the second titration. You are again prompted for adding 1 ml iodate.
After the second titration the Determination window will pop up again.
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Figure 4.13 Additional Blank Determination

Note that the window has an additional push button, labelled 'OK'. You can decide to make
another titration to get a more precise blank value by selecting 'Next' or save the current value
by choosing OK. The total number of blank titrations is limited to eight. Therefore, the Blank
Determination Window contains no 'Next' button after the eighth titration. Like for
standardization you can disable single titration results if they seem to be inexact. The first
titration result cannot be disabled, because it is necessary to calculate the blank value.

When all titrations are done, choose 'OK' and you will return to the Blank Value window, which
now displays the new blank value and the current system date and time. As at
standardization, the new blank value is saved to disk.

This is the point where we can start our first real oxygen determination. Leave the Blank
Value window and select the Main menu option Titration.
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4.10 Titration

Figure 4.14 Titration

The Titration window contains an entry field group with many items. Some of these items are
optional; others must have valid entries to start a titration. Here is a detailed description of all
entry fields:

Date: The Date is an optional part of a data set. By default this field will hold
the current date. To enter a new date use the formats 'dd.mm.yy' or
'dd.mm.yyyy'.

Time: The Time is an optional part of a data set. By default this field will hold
the time when opening the Titration Window. To enter a new time use
the format 'hh:mm'.

Station: The Station name is an optional part of a data set. Before starting a
titration you may enter any kind of alphanumeric information up to a
length of 15 characters. By default this field holds the station name from
the last titration.

Depth: The Depth is an optional part of a data set. Before starting a titration you
can enter the depth of your sampling (max. 5 digits). By default this field
holds the depth from the last titration.

Bottle Number: The number of your sampling bottle. Before you can start any titration
you have to enter a valid bottle number. For new bottle numbers see the
Add Bottle Window in the Bottles Window.
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Sample Temp. Tsw: The temperature of your sample at the time of sampling. This
temperature is used to convert volumetric oxygen concentrations (ml/l)
into weight concentrations (µM/kg) and O2 saturation. Valid temperatures
are in the range from -2 to 40 °C.

Pickling Temp. Tp: The temperature of your sample at the time of pickling (filling your
bottle). The Pickling Temperature is used to calculate the real bottle
volume at the time of filling the bottle. Valid temperatures are in the
range from -2 to 40 °C.

Titer Temp. Ttit: The temperature of your thiosulphate titer at the time of titration
(probably now). The Titer Temperature is used to correct the titer volume
relative to the titer temperature at standardization.

Salinity: The salinity of your sample, if known. The salinity is used to convert
volumetric oxygen concentrations into weight concentrations and O2
saturation (see also Sampling Temperature). Valid values are in the
range from 0 to 43 psu.

Reagent Volume: The volume of your sample in ml displaced by the reagents (MnCl2 and
NaOH/NaI). The default values are 2 ml for WOCE mode and 3 ml for
ISO mode.

Abs. Reag. Oxygen: The absolute amount of oxygen in ml added with the reagents. By
default this field will hold the value from the last titration. The default
values are 0.0017 ml for WOCE mode (Murray et al., 1968, valid for
reagent volumes of 1 ml each) and 0 ml for ISO mode (ISO does not
support this correction, but if you enter any value, it is used).

Comment: The Comment is an optional part of a data set. By default this field will
hold the comment from the last titration. To enter a new comment just
type any printable character up to a maximal string length of 18
characters.

Protocol: Use the <Space-Bar> to toggle this option on or off. When Protocol
printing is enabled, the results will be printed in a short form to your line
printer after each titration. Ensure that your line printer is ready for
printing.

Duplicate Sample: Use the <Space-Bar> to toggle this option on or off. When Duplicate
Control is enabled (see the Configuration Window in the Options Menu)
you can specify that this titration will be a duplicate one. After opening
the Titration window and after each titration this switch is automatically
toggled off.

File Name: The name (and optional drive and path) of the file to which the titration
results will be written. To get a list of existing data files press the function
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key <F2> to open the File Select window. The usage of the File Select
window is described later in this chapter. Before you can start a titration
you must enter a valid file name. Note that there are four types of data
files (with or without duplicate samples and WOCE or ISO mode).
Therefore you can select or enter only data files matching the current
type (see Duplicate Control and Method in the Configuration window).

Start: Start the titration of your sample. Be sure that all inputs are correct.

Cancel: Leaves the Titration Window and takes you back to the Main Menu.

If you have entered your data, you can start the titration. This is the second point at which we
find differences between the old (1-channel) and the new (2-channel) hardware. Basically the
titration will run as described above for standardization and blank determination, but for 2-
channel systems another window will pop up before the first titration begins.

Figure 4.15 Input of Maximal Transmission

Inside the Input Maximal Transmission window it is possible to change the value of the
estimated endpoint. If you have a turbid sample, the estimated value may be too high so the
value can be changed to avoid an over titration. Note that decreasing the estimated endpoint
results in increasing titration times. Normally the Estimated Endpoint is calculated from the
red transmission, a correction factor, and a general offset. Turbid samples, especially
samples with photosynthetic micro-organisms, will have a higher blue than red light
absorption.
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The displayed blue and red transmission values cannot be changed; they are the current
percentage transmissions of the beams. The Estimated Endpoint entry field below will hold a
value calculated from the red transmission and a correction factor.
If you select the 'OK' push button the titration will start. Again you will see the Titration
Running window.

Figure 4.16 Titration Running

During titration the current titration values (titer amount, percentage transmission, estimated
endpoint, titration time and current action) are displayed continuously in the Titration Running
Window. If you wish to interrupt the titration, just press <Escape> and confirm the User Break
Message with 'OK'. Note that you can go on with the titration by selecting 'Cancel'. But if you
are already in the slow titration phase the results may be inexact for longer (more than two
seconds) delay times.

When the titration has successfully completed, the Titration Running window will be closed
and the results are displayed in the Titration Finished window.
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Figure 4.17 Titration Finished

The displayed values are:

Accuracy: This value is calculated during the approximation of the titration curve
and gives you information about the accuracy of the endpoint
calculation. It is the percentage standard deviation relative to the
calculated titer volume. If there are many titration steps and little noise,
the accuracy value may be very good (better than 0.01 %), because of
the optimization algorithm. Since the accuracy is given relative to the titer
volume and not to the burette volume, it will be greater for lower oxygen
concentrations!

Titer volume: The calculated titer volume at the titration endpoint.

O2 concentration: The O2 concentration in ml/l, mg/l, µM/kg and the percentage O2
saturation.

Titration time: The total titration time.

The Titration Finished window gives you four selections to choose from. The option 'Graph'
does the same as the 'Graph' item in the Main menu and will be described later. Since this is
not the time to view the 'Print' menu, choose the 'OK' button to go on.

If you are not inside a duplicate sample titration the data will be saved and you will return to
the Titration window. Otherwise another window will pop up, prompting you for the bottle
number of the second bottle.
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4.11 Duplicate Sample Titration

Figure 4.18 Second Bottle Number

After the second titration, the Titration Finished window will pop up again to display the results
of the second titration. When you leave this window you will progress to the Duplicate Sample
window.
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Figure 4.19 Duplicate Sample Results

The Duplicate Sample window displays at the bottom the results and difference of the two
titrations and at the top the statistics of the current data file, including the current results. For a
complete description of the statistic values and calculations see the users manual.

Choose 'OK' to save the data of both titrations and the updated statistics in your data file. If
you choose 'Cancel', neither the titration data nor the updated statistics will be saved.

Now you are back in the Titration window. Note that the default push button selection is now
'Cancel'. If you want to make another titration, enter your data and start. If you are in the
demonstration program and Duplicate Control is enabled, try to make a duplicate titration to
see the results.

It is now time to examine a titration curve from the Main menu option 'Graph'.
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4.12 Graph Menu

Figure 4.20 Graph Menu

The option 'Log File Graph' lets you display the graph of a titration that was saved with the log
command. We want to examine the graph of the last titration, so choose 'Titration Graph'. If
the last titration was not successful or no titration was done since program start, an error
message is displayed.
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Figure 4.21 Titration Curve

The graphic menu contains some display options and lets you print the curve to your line
printer.

<Esc>: Leave graphics mode.
<G>rid: Graphic display with or without grid.
<L>in/Log: Graphic display with linear or logarithm transmission values.
<D>ata field: Toggle data field on/off.
<P>rint: Print graphic to your line printer (the printer must be EPSON-FX or HP

PCL compatible for printing in graphic mode).
Zoom <I>n: Enlarge view port.
Zoom <O>ut: Reduce view port.
<Left>: Move graph view port to left.
<Right>: Move graph view port to right.

At the bottom right of the screen some important information relating to your graph will be
displayed. This includes the current date and time, the calculated endpoint and the accuracy
of the endpoint calculation. If the curve is partional hidden by the data field it may be removed
from the screen by pressing ‘D’. The graph itself will mark the beginning of the slow titration,
the inflection point of the approximated function and the calculated endpoint. If an
approximation was possible this function will be drawn from the slow point to the inflection
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point and the corresponding e-function will be drawn from the inflection point to the endpoint.
For a detailed description of the titration algorithms and the meaning of the individual points
see the user manual.

4.13 File Selection

Now let's have a look at the data files. Open the File menu and select the View Data option.
First choose a file from the File Select window.

Figure 4.22 File Selection

The 'Name' field lets you enter the name of a data file, a drive, a directory specification, or a
search mask. When the File Select window comes up on the screen, this field will hold the
standard search mask for data files "*.DAT". The list below will display the parent directory
("..\"; assuming the current directory is not the root directory), all sub directories ("subdir\") and
all matching data files from the drive and path displayed beneath the list. With the Drives list
you can quickly change to another drive instead of entering specific drive letters in the Name
field. At the bottom of the window you will see some more information about the currently
selected file (Name, size, date and time). Move to the file list and select your desired data file
or enter the data file name at the 'Name' field and press <Enter> or activate the 'Open' button.
Note that only valid data files will be displayed in the list box (each file is checked for an
identification string). Therefore, the scanning of a directory could require some time to identify
the data files, especially for directories with several files or for disk drives.

The Data Overview window follows the file selection.
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4.14 Data Overview

Figure 4.23 Data Overview

The Data Overview window gives you a total view of all data sets in a data file. To move
through the file, to view a special data set or data set field, use the mouse or the keys as
described above. As well as other list boxes, there are many keyboard commands to ease
your way through this complex box.

<Up>: Previous data set
<Down>: Next data set
<Left>: Column left
<Right>: Column right
<Home>: First data field of data set
<End>: Last data field of data set
<PgUp>: Previous page
<PgDn>: Next page
<Ctrl-Left>: Data field left
<Ctrl-Right>: Data field right
<Ctrl-Home>: First data set on screen
<Ctrl-End>: Last data set on screen
<Ctrl-PgUp>: First data set in file
<Ctrl-PgDn>: Last data set in file

For a more detailed description of the data field titles take a look at a single data set.
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At the bottom of the window there are three or four push buttons, depending on the current
data file type. Let us now step through the options. The first push button is labelled 'Single'
and will display the currently selected data set in a wide, screen filling format.

4.15 View Single Data Set

Figure 4.24 View Single Data Set

This window displays one data set with the following data fields:

Date: Your date input
Time: Your time input
Station: Name of station or ship
Depth: Depth of sampling
Salinity: Salinity of sample
Blank volume: Blank correction
Standard volume: Titer volume of standard determination
Iodate volume: Volume of titrated iodate from standardization at standardization

temperature
Iodate normality: Normality of iodate standard from standardization at

standardization temperature
Titer concentration: Titer concentration (only for ISO mode)
Reagent volume: Amount of the added reagents
Abs. reag. O2: Absolute amount of oxygen added with the reagents
Method: Used method for the standard determination and the titration
Comment: User comment
Bottle number: Number of the sample bottle
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Bottle volume: Sample bottle volume at the pickling temperature
Bottle volume (20°C): Sample bottle volume at the reference temperature of 20 °C
Cubical expansion coeff.: Cubical coefficient of thermal expansion of the sample bottle
Sample temperature Tsw: Temperature of the sample at time of sampling
Pickling temperature Tp: Temperature of the sample at time of bottle filling
Titer temperature Ttit: Titer temperature at time of titration
Accuracy of endpoint: Accuracy of endpoint calculation
Titer volume: Calculated amount of titer, representing the amount of dissolved

oxygen in the sample
O2 concentration: Calculated O2 concentrations

If the data set is part of a duplicate sample a note will be displayed below the data.

If your data file is prepared for duplicate samples, there will be four push buttons and the third
is labelled 'Deviation'. Activate this button to get statistics about the duplicate samples in the
data file.

4.16 View Statistics

Figure 4.25 View Statistics

Description of the statistic data:

Number of replicates: The total number of duplicate samples in the data file.
Number of single samples: The total number of single samples in the data file.
Replication ratio: The percentage ratio of the number of duplicates to the sum of

the number of duplicates and the number of single samples.
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Max O2 concentration: The maximal measured O2 concentration from this data file.
Standard deviation σ: Standard deviation of all concentration differences from the

duplicate samples.
Reproducibility: Reproducibility of all duplicates relative to the maximal O2

concentration. This value is calculated from the above standard
deviation.

The second push button is labelled 'Print'.

4.17 Print Menu

Figure 4.26 Print Menu

The Print menu can be opened from many windows for data output of the window specific
data. At the above screen shot you see an example from the View File window. This menu
lets you print data to the line printer, to a text file or to some specific DOS devices. At the top
of the window is an entry field for the file name or the DOS device to which the data should be
printed. You can enter any valid file name that matches the DOS specifications for file names
including an optional drive letter or an optional path. If the file exists already, you will get a
warning message with the options of overwriting the file, appending the data to the file or
cancelling the print job. Apart from file names you can enter a DOS device PRN, AUX, LPTn
or COMn, where 'n' is a number between '1' and '4'. Printings to text files always contain only
ASCII characters including the IBM graphic and national characters. Each line will be
terminated by a carriage return / line feed sequence. If you select the printer output, the data
will be printed to the device selected in the Configuration window. Before printing to devices
the system will always check if the corresponding device is ready.
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To see the printing formats just select your desired option, open the Print menu and write the
data to a text file or to the printer. If you printed to a text file you can view the file with the Text
File option from the main menu. You can also view the text file at DOS level with any text
editor or the DOS TYPE command. If you do not want to quit the program to execute a DOS
command, you can select the OS Shell option in the File menu.

4.18 OS Shell

Figure 4.27 OS Shell

With the OS Shell option you will leave the program temporarily and will be taken to the DOS
prompt. To return to the program, type "EXIT <Enter>". This is useful when you want to run a
DOS command or another program without quitting the program. The memory use of the
DOA software is minimized by swapping to give you enough memory for most programs.
Note that it is impossible to return to the DOA software if resident programs are installed from
the OS shell.
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4.19 Hardware Test

Figure 4.28 Hardware Test

In addition to the information about the remaining amount of memory this option will check
your hardware, provided you are not within the demonstration version. If you are, a reference
to the demonstration mode will be displayed.

The status displayed for each test indicates:

Detected: No errors (Photometer and Dosimat)
Not Detected: Hardware not found (Photometer, Hardware Version and Dosimat)
1-/2-channels: The hardware version. If you are working with a 2-channel system and

the program detects only a 1-channel system, check the cable between
computer and titrator.

OK (nnn %): The transmission is in the valid range.
Too high (nnn %): Transmission is too high, calibration necessary
Too low (nnn %): Transmission is too low, calibration necessary

Note that the photometer has a warmup time of about five minutes and that the transmission
values in the warmup phase could be out of range.

If the photometer values are out of range you can test the photometer operation with the
Transmission Test item in the Options menu.
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4.20 Transmission Test

Figure 4.29 Transmission Test

In this window the photometer values of the blue and red (for 2-channel systems) beams will
be displayed continuously. The output is in percentage transmission. Note that greater values
than 100% are possible and valid. If you are running the demonstration program a reference
to the demonstration mode will be displayed.
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4.21 Log File Graph

If you have saved some titration data with the Log command you can load these data to
display the titration curves. Select the Graph option from the main menu and choose 'Log File
Graph'. At first you must select the log file from the File Select menu. Then you can choose
the desired data set for display.

Figure 4.30 Select Data Set from Log File

Select the data set and activate 'Graph' for display of the titration curve. After leaving the
graphics display you are returned to this window for another selection. Note that the date and
time stamp are not the titration time but the time of data logging.
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4.22 Titration Parameters

Figure 4.31 Titration Parameters

This menu gives you full control on all titration parameters and lets you save them in the
configuration file. For a complete description of the parameters see the User Manual. Please
note that it is very important to have proper parameters, because titrations can fail otherwise.
If you are in the demonstration program the timing parameters are not used.

Step size The step size defines the amount of titer that is dispensed on every step in the
slow titration phase. The smallest possible amount is 1/10000 of the burette
volume. The absolute amount of titer in µl for one step is calculated according
to the current burette volume and is displayed behind the entry field.

Wait time After the fast titration phase, the system has to wait some time to ensure that
the total amount of dispensed titer has reacted.

Fast delay This parameter specifies the delay time after each step in the fast titration
phase.

Slow delay This parameter specifies the delay time after each step in the slow titration
phase.

Fast factor This parameter exists only when a 2-channel system is used. The factor defines
up to what transmission, relative to the estimated endpoint, the fast titration
phase will run.
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4.23 Dosimat Functions

Figure 4.32 Dosimat Functions

Dispensing Volume Entry field for the volume that will be dispensed when activating
the Start button.

Continuous dispensing Continuously dispense and fill burette. This option is useful if you
want to flush your burette.

Start Start dispensing.
Stop Stop current dispensing. After activating the Start button it will

change to a Stop button.
Fill Fill the burette and reset the total volume.
Help Opens the help screen for the Dosimat functions.
Cancel Leave the Dosimat window.

Total dispensed: Total amount of dispensed titer since last Fill activation.
Remaining in burette: Current amount of titer in the burette.
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Glossary

ASCII (American Standard Code for Information Interchange)
A set of 256 codes that many computers use to represent letters, digits, special
characters, and other symbols. Only the first 128 of these codes are standardized; the
remaining 128 are special characters that are defined by the computer manufacturer.

Coprocessor
Hardware product that provide very fast and precise number processing.

Device
Computer input and/or output unit (e.g. printer, keyboard)

D-SUB connector
Special form of a plug connector.

EN (Europäische Norm)
See ES.

ES (European Standard)
International standard from the European Committe for Standardization (CEN).

ISO
International standard from the International Standardization Organisation.

Mouse
Hand held computer input unit.

NE (Norme Européenne)
See ES.

Port
Computer hardware interface to external devices.

RS 232 (C)
International hardware standard for serial connections.

Winkler (Winkler's method)
Chemical method for the measurement of dissolved oxygen in aqueous solutions.

WOCE (World Ocean Circulation Experiment)
International hydrographic working group.
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